[bookmark: _Hlk478975998]Excel-to-Word Document Automation Add-In
Update/create Word and PowerPoint content (text, tables, and charts) based on Excel data and calculations.
[image: ]
Advanced Features Template and How-To Guide
This document demonstrates select “advanced” capabilities of the add-in
	Section
	Worksheets (Data Source)
	Description

	Text, Lists, and Paragraphs
	Text & Lists
	Excel-sourced text can be incorporated into documents in a variety of ways. This section shows how to: 
· Add text to various document content types (titles, paragraphs, shapes, etc.)
· Incorporate/update data within text
· Dynamically create lists and paragraphs (based on Excel formulas)

	Tables
	Tables
	The add-in was designed to support a variety of table updating scenarios. This section describes/demos key table features:
· Source Excel data can be based on named ranges or tables (data tables)
· Table formatting set in Word/PowerPoint will not be modified after the update
· Supports tables with merged cells
· Tables automatically resize to match source (Excel) table size
· Updates of specific cells can be disabled
· Tables can be configured to hide rows if hidden in Excel

	Image of Ranges
	Range Image
	Transfers the image of the named range, just as it appears in Excel. The range can include SparkLines, product images, Maps, SmartArt, people photos, and Conditional Formatting in cells.

	Charts Images
	Chart Images
	Essentially any chart type is supported and charts can contain a variety of added content (text, images, etc.)

	Charts from Tables
	Charts
	Updates Word charts based on a range or table in Excel. Updates must be done through Word Cloud Updates. See examples on our template page “AnalysisPlaceWordCharts” 

	HTML
	HTML
	Enables inserting HTML content into Word. Format text (bold, colors), add hyperlinks, insert images from URLs, etc. HTML can be created dynamically.

	Layout Options
	Misc
	Dynamic content can be incorporated in a variety of ways (not just in-line), enabling great-looking documents/presentations.
Content can also be updated in headers and footers (Word) and PowerPoint master slides

	Conditional Sections (Document Assembly)
	Conditional Sections
	Describes how the add-in can include/exclude document sections, similar to "Document Assembly". Conditional Sections automatically removes un-needed Word sections or PowerPoint slides.

	Mail Merge
	Mail Merge
	Shows how to quickly update multiple documents (one at a time) based on a table or database of information. Typically each row/record would contain data to update each document.

	Localization – Currency
	Currency
	Shows how to change currency symbols and exchange rates in your Excel and destination documents 

	Localization - Language
	Language
	Shows how to switch languages. Typically users have a destination document for each language and Excel is used to update the dynamic content in the destination document.

	Import Data (getting data into Excel)
	Misc
	Users commonly import data from external sources into Excel, so it can then be analyzed and updated in Word and PowerPoint documents. Common data sources include website data; databases; Azure; CRM/ERP systems, such as Salesforce; other Excel workbooks, web services, XML/JSON data, etc. 


[bookmark: _Toc531342343]Introduction
This document along with the “AnalysisPlace Advanced Features.xlsx” workbook (and if desired, “AnalysisPlace Advanced Features.pptx”) shows how the add-in can enable a variety of advanced data-focused document automation scenarios. 
To use this document: 
1. Activate the add-in in the “AnalysisPlace Advanced Features.xlsx” workbook and this document. 
2. Make changes to any of the tan input cells in the workbook in one or more of the desired worksheets 
3. “Submit Content” in the workbook add-in
4.  “Update Document” in the add-in in this document. You should be able to see the changes, based on your Excel modifications
Most of the features also work with Cloud Updates (requires an Enterprise license). Some features (Conditional Sections) only work with Cloud Updates.
You are welcome to modify and use the content in these documents for your own use.
[bookmark: _Text,_Bullet_Lists,][bookmark: _Toc531342346][bookmark: _Toc531342344]If you are not already familiar with the basic features of the add-in, first see:  See https://analysisplace.com/Document-Automation/Get-Started
Text, Bullet Lists, and Paragraphs
Excel-sourced text can be incorporated into documents in a variety of ways. 
Single-cell named ranges update text items (e.g. titles, paragraphs, parts of text, lists) in Word/PowerPoint.
All linked content in Word is included in Content Controls. You can hide the Content Controls (e.g. before sending to customers) by selecting “Hide” at the bottom of the “Link” tab in the add-in.
Add Text to Various Document Content Types
Linked text can include or can be within: paragraphs, titles, text boxes, most shapes, WordArt, headers/footers, or a table cell. You can style the text as desired (colors, bold, font, etc.) and the style will remain after the update. 
 This example shows the linked text within a shape:
Customer XYZ

Combining Text and Data 
Data can easily be combined with text using the text() formula in Excel:
Customer XYZ will save $900,000.
Lists and Paragraphs
The add-in can create lists that change based on formulas in Excel. List are based formulas in a single cell.
· Lists from Excel (a single link/control) can be styled as bullets or numbered lists. 
· Alt-enter is typically used for manually created lists.
· Char(10) is used if you want to list to change dynamically (part of a formula).
· In cloud-created reports (PowerPoint or template-based Word reports), you can add multiple levels (indents) to your bullet lists by adding a greater-than symbol ">" to the start of the line in Excel. Add 2 ">>" for level 2 or  ">>>" for level 3 indents. These can be added dynamically to formulas.
This example shows a dynamically created (based on an Excel formula) bullet list:
A. Project Summary
Customer XYZ will save $900,000.
Payment must be received by May 26, 2021.
The customer will be happy.
In this example, the items are an automatically numbered list:
B. Project Scope
Basic Features
Management Module
Implementation Services
Maintenance
Support Services
This example shows dynamically created (Excel-sourced) paragraphs:
Legal Details
Lorem ipsum dolor sit amet, ei cum apeirian voluptaria. Lorem debitis liberavisse ex cum, fugit consulatu consequuntur eam eu. Te sea oratio utinam qualisque, inani numquam eruditi quo ei. Choro fierent cu eos, ex omnis eruditi nec. Graece consetetur consectetuer qui an.
Ut ludus omittam mea, eu has harum cotidieque, te per libris minimum rationibus. Dolore vituperata honestatis vim ei, erat decore blandit ea usu. Vero invenire eos ne, duo ea oporteat scribentur, essent volutpat eum ei. Ex eos ceteros invenire, timeam omnesque constituam ut mea. Cum integre epicurei comprehensam et, an cum iudico nominati interesset. Cu nam sanctus laoreet, ad ignota tibique tacimates eum.
Quas nonumes fuisset te pro, mei ad dolores vivendum, vim ei tantas dolorem. Id mentitum qualisque sit. Id mel quot delectus. Tibique perpetua vix te, vim assum senserit cu. At his quis sumo simul, apeirian forensibus eam ut. At sale repudiandae mel, vis cu ullum placerat iracundia. In vis quis labores apeirian, liber tempor qui cu, sea ut graeci instructior consectetuer.
Ex ius posse vivendo. Ea per quod scripta. Lucilius lobortis ei quo, ei zril maiestatis percipitur vel. Iudico suscipit sit te, patrioque deseruisse mnesarchum pri no, sea cu movet labitur accusam. Est homero apeirian concludaturque et.
[bookmark: _Image_of_Ranges][bookmark: _Toc531342345]Tables
The add-in was designed to update Word/PowerPoint tables for a variety of scenarios, including updating large/complex tables, such as financial reports. 
This section describes/demos key table features. Also, see the companion workbook for Excel-specific instructions.
Named Ranges Vs. Data Tables
Source Excel data can be based on named ranges or tables (data tables). They both can update Word/PowerPoint tables the same way. The first and third tables below are based on named ranges; the second is based on an Excel table.
Create and Format Tables
In Word, you can link tables in 3 ways (first Add-in > Link > “Get Excel Source Data” > Select your table source from the drop-downs):
1. Insert a new table:  (Ribbon > Insert > Tables > Table); format the table (Ribbon > Table Tools > Design); select the entire table by clicking the icon above/left of the table; then link the table (Add-in > Link > “Insert Content / Update Link”).  
2. Link an existing table: select the entire table, then “Insert Content / Update Link“ button. The table should have the same number of rows/columns as the source Excel table/range.
3. Insert and Link: put the cursor where you’d like the table, then simply click the “Insert Content / Update Link“ button. 
You can style tables (Table Styles, borders, font, colors, etc.) and the style will remain after the update (only the text will update).
Automatic Table Resizing (Insert/Delete Rows/Columns)
The add-in will try to resize Word/PowerPoint tables to match the size of the source Excel table/range. For example, if the Excel table has 7 rows and the Word table has 4, the add-in will insert 3 rows. The next-to-the-last row/column will be used for the format template for the inserted rows/columns.
There are some limitations, for example, the Word add-in cannot insert/delete columns if there are merged cells in the table.
[bookmark: _Tables_–_Merged]Table Merged Cells
The add-in supports most Word/PowerPoint table merged cell scenarios. The table below contains 2 merged cell areas in the 1st row.
 	 	Initial One-Time	Annual On-Going	
Description	Units	Qty	Cost Each	Total	Qty	Cost Each	Total	3-Year Total
Product A User Licenses	Licenses	95	$200 	$19,000 	95	$50 	$4,750 	$33,250 
Product A Server Licenses	Server CPUs	4	$4,000 	$16,000 	4	$1,000 	$4,000 	$28,000 
Implementation Services	Person-days	6	$1,600 	$9,600 	0	$1,600 	$0 	$9,600 
Training Services	Days	10	$2,000 	$20,000 	3	$2,000 	$6,000 	$38,000 
Support Services	Incidents	0		$0 	10	$1,000 	$10,000 	$30,000 
Total				$64,600 			$24,750 	$138,850 

If the add-in does not place content in the desired Word cell, try adding a space to the empty Excel cell to the left of the data that ends up misplaced.
[bookmark: _Disable_Specific_Table][bookmark: _Toc531342347]Disable Specific Table Cell Changes
To avoid updating individual table cells in Word/PowerPoint tables:  In the desired table cell in Excel, enter a "!~" (without the quotes) at the start of your cell text/formula. Or use UNICHAR(8205) at the start of your formula (which is an invisible character). The Word/PowerPoint add-in will not update cells if the source cell text from Excel starts with those characters.
This is useful to avoid updating content that will never change or if you have cells with mixed formatting that you do not want to be replaced.
It is also useful for multi-lingual reports/outputs -- if you have a single Excel workbook/tool and multiple-output reports (one for each language). This will enable you to update the numbers in Word/PowerPoint tables without overwriting the text (e.g. row/column headers) in the cells. For cells that contain mixed numbers and text, you could add the multi-lingual text to formulas based on lookups.
[bookmark: _Charts_/_Graphs][bookmark: _Toc531342350][bookmark: _Toc531342349]Hide Table Rows
To include visible rows/columns only: in Excel, add the suffix "_visible" (or "_vis") before the range or table name. Hidden, filtered, or grouped rows will not appear in your Word/PowerPoint table. Can be combined with _body. 
The table below demonstrates this – it only includes visible rows in the source Excel table. The table is resized to match the Excel table visible row and column counts.
Merchant	Date	Category	Amount
The Phone Company	5/26/2021	Communications	$120.00
Best For You Organics Company	5/24/2021	Groceries	$27.00
Coho Vineyard	5/23/2021	Restaurant	$33.00
Trey Research	5/21/2021	Other	$135.00
Best For You Organics Company	5/20/2021	Groceries	$97.00




Table Updating Speed and Limits
Word table updating performance can become slow when the document contains dozens of large tables. Update performance is significantly faster if the user's cursor is at the top of the document and no/few large tables are visible. Slow update speeds are related to native Word display updating, not the add-in. Cloud reporting (Enterprise version) is fast, even for very large/complex documents.
Currently, the Word add-in can only update 49 tables in a document per update. Cloud reporting (Enterprise version) does not have this limit and can be substantially faster.
For more details, see https://analysisplace.com/Resources/Technical-Limits
Simple Financial Statement Example
This example demonstrates that the destination content appearance can be very different from the source Excel format.
	5/26/2021	% of Revenue
Total Revenue	$800,000,000 	100%
Cost of Revenue	$440,000,000 	55%
Gross Profit	$360,000,000 	45%
Operating Expenses		
Research and Development	$104,000,000 	13%
Sales, General and Admin.	$160,000,000 	20%
Non-Recurring Items	$16,000,000 	2%
Other Operating Items	$8,000,000 	1%
Operating Income	$72,000,000 	9%
Add'l income/expense items	$8,000,000 	1%
Earnings Before Interest and Tax	$80,000,000 	10%
Interest Expense	$8,800,000 	1%
Earnings Before Tax	$71,200,000 	9%
Income Tax	$21,360,000 	3%
Net Income	$49,840,000 	6%




Image of Ranges
This feature transfers the image (PNG) of the named range, just as it looks in Excel.
Name the cell or range of cells (starting with the prefix and ending with "_img"). Include any content in the range (conditional formatting, sparklines, images, shapes, text boxes, smart art, dynamic items, etc.) The image (PNG) of all content in the range will be transferred to your Word/Ppt document just the way it appears in Excel. 
Some users choose to transfer images of tables instead of updating text within each cell. This may be easier than formatting tables in Word/PowerPoint, however, it will significantly increase transfer size and will make the Word/PowerPoint file much larger.
Note: Currently, this is only compatible with Office for Windows. It is not yet compatible with Macs. In Office Online, it only transfers content within the range (including conditional formatting), but not items added on top of the range (such as images). The same image content can be transferred to Word/PPT by putting the content on charts, then submit the chart image (this works on Macs).
Image-based on range containing a variety of formula-based elements
This example shows sparklines, conditional formatting, and a chart in a range. The source of the image below is a named range in Excel.

Image updated based on user selection or cell formula
The example below displays a flag image based on a country that is selected from a drop-down list in Excel. It shows an image that appears in a single cell in Excel.
This technique is commonly used to display product images based on selected/configured solutions. Some common examples include customized logos and personalized photo.
Country Selected: Andorra

Depending on your needs, there are also many ways to use VBA macros (and other add-ins) to modify the image displayed in the cell (which can be updated in Word/PowerPoint).
Images could also be based on a URL from a remote website.


Charts / Graphs
Charts can be updated in two ways in Word. The way described in this document is that the chart image (PNG) will be transferred to your Word/PowerPoint document. So format them in Excel the way you want them to look in your document.
In the Word and Excel documents titled “AnalysisPlaceWordCharts”, we describe the second way of updating, which is by linking the chart to a table in Excel and updating it through the cloud. Those templates can be found in our resource guide. https://analysisplace.com/Resources/Templates
You can use essentially any type of chart/graph.
Image Size, Quality, and Resolution
	You can change the image size and resolution.  Higher-resolution charts appear sharper in Word/PPT, but also increase transfer size and Word/PowerPoint file size.
To Resize Chart Images: append your chart name with '_h' and the desired height in pixels or '_w' and the desired width in pixels. For example, 'rpt_Chart_w250' creates the image so it is 250 pixels wide (8.8 cm / 3.5 inches). The non-specified dimension scales so the aspect ratio remains the same.
In Word, you can constrain the image size by placing the image within a container, such as a text box or a table with the cell Auto-Fit set to "Fixed Column Width". If you don’t contain it, by default, its size in Word/PowerPoint will be the same as its size in Excel. The image above is within a text box to control the image size.
	





Charts with Added Content
You can include other content to your charts, such as dynamic text, images, shapes, etc.
This feature can enable very powerful/flexible content automation capabilities.
The chart below contains formula-based text and an image which will update based on the growth rate:
[image: ]


[bookmark: _Hide_Table_Rows][bookmark: _Headers,_Footers,_and][bookmark: _Layout_Options][bookmark: _Toc531342355]

[bookmark: _HTML]HTML
This feature enables extensive added formatting/content options, for example: 
· Format text via header tags, like <h1>
· Format content via the style= attribute. For example, change font size and color
· Insert images from a URL via the <img> tag
· Hyperlinks: <a> tag
· Lists: <ol><li> and <ul> tag
· Tables: <table> tag
· Emphasize text via the <b>, <strong>, <u>, <i>, and <em> tags
The HTML content in the source Excel cell can be created via formula or programmatically (VBA macros, other add-ins, or external applications).
The name of the Excel cell must end with “_html” to insert the content as HTML.
Some HTML content is not compatible: for example: </br>, CSS styling
Note: when creating reports via Word Cloud (Enterprise Feature), the image will not appear until the opens the document and clicks “Enable Editing”.
This example inserts text and a table with basic formatting:
HTML formatting examples: bold; red.
Table:
Month	Savings
January	$100
February	$125


This example inserts lists:
Ordered List:
Coffee
Tea
Milk
Unordered List:
Coffee
Tea
Milk
  
This example inserts an image (a fantastic company’s logo) with a hyperlink:
AnalysisPlace


This example dynamically (based on a user selection and Excel formulas) creates HTML with a title, an image, text, and a hyperlink:
Jaguar E-Type

The Jaguar E-Type, or the Jaguar XK-E for the North American market, is a British sports car that was manufactured by Jaguar Cars Ltd between 1961 and 1975. Its combination of beauty, high performance, and competitive pricing established the model as an icon of the motoring world. The E-Type's 150 mph (241 km/h) top speed, sub-7-second 0 to 60 mph (97 km/h) acceleration, monocoque construction, disc brakes, rack-and-pinion steering, and independent front and rear suspension distinguished the car and spurred industry-wide changes. The E-Type was based on Jaguar's D-Type racing car, which had won the 24 Hours of Le Mans three consecutive years beginning 1955, and employed what was, for the early 1960s, a novel racing design principle, with a front subframe carrying the engine, front suspension and front bodywork bolted directly to the body tub. No ladderfame chassis, as was common at the time, was needed and as such the first cars weighed only 1315kg (2900lb).
Learn More


Layout Options
Dynamic content can be incorporated in a variety of ways (not just in-line) enabling great-looking documents/presentations.
WordMerchant
Date
Category
Amount
The Phone Company
5/26/2021
Communications
$120.00
Best For You Organics Company
5/24/2021
Groceries
$27.00
Coho Vineyard
5/23/2021
Restaurant
$33.00
Trey Research
5/21/2021
Other
$135.00
Best For You Organics Company
5/20/2021
Groceries
$97.00


The content controls can be placed in-line with text (the default) or you can insert the controls within containers, such as text boxes, and these containers can be placed anywhere (not just in-line with text). This enables very powerful/flexible layout options, such as updatable dashboards, infographics, and great-looking personalized branded marketing/sales material.
In the example to the right, a table is placed inside a text box and the text box wrapping style is set to square.
PowerPoint
All PowerPoint content is shape-based. Shapes can be titles, text boxes, tables, images, etc. Shapes are tagged (with the link code in the shape’s alt-text property) and updated by the add-in. Shapes can be placed anywhere on a slide (including overlapping). A slide can contain many shapes. Slides and shapes can be copied/pasted and will retain their links.
[bookmark: _Toc531342353]Headers, Footers, and Master Slides
In Word, linked text can be placed in headers and footers.
In PowerPoint, master slides can contain linked content.
[bookmark: _Mail_Merge][bookmark: _Toc531342354]

[bookmark: _Conditional_Sections_(Document]Conditional Sections (Document Assembly)
Only compatible with Word Cloud Reports (Enterprise Feature) – would delete document content in add-in updates.
AnalysisPlace can not perform "Document Assembly" per se, but it can do the equivalent: It can automatically delete un-needed sections from the template. So include all needed content in your Word or PowerPoint templates, then configure your workbook to automatically indicate (e.g. based on formulas) which sections to delete, depending on the user scenario.		
In Excel, The "ReportSectionsToDelete" table (if it exists), determines which sections of created Word or PowerPoint reports will be deleted when updated on the server.		
Common examples of “optional” content (which can be deleted based on the scenario):
· [image: ]Industry-specific case studies:  case studies for all industries are included in the master Word/PowerPoint document, then all but the desired industry case study are deleted when the report is created/updated for a specific customer.
· Report (e.g. proposal) sections: all sections are included in the master document, then when the report is created/updated for a customer, unneeded sections are deleted.

In Word, “sections” are defined by Bookmarks (in the Office ribbon: Insert > Links > Bookmark).  Bookmarks can define small (a word) or large (pages) areas. Bookmarks can be nested.
The sections below demonstrate how this feature works. Sections will be deleted depending on the Scenario selected in the “Conditional Sections” input cell in Excel. In the template, there are/were 7 sections below:
[bookmark: SectionName]SectionName
	Section content
[bookmark: CostAnalysis]CostAnalysis
	Section content
[bookmark: CaseStudyA]CaseStudyA
	Section content
[bookmark: CaseStudyB]CaseStudyB
	Section content
[bookmark: FinancialAnalysis]FinancialAnalysis
	Section content
[bookmark: AppendixA]AppendixA
	Section content
[bookmark: AppendixB]AppendixB
	Section content


Mail Merge
Mail merge is defined as the automatic addition of names and addresses from a database to letters and envelopes to facilitate sending mail, especially advertising, to many addresses.
The add-in was not designed for high-volume automated mail merge and it should not be used as a replacement for Word’s native “Mailings” (Mail Merge) features.
The add-in can effectively be used to lookup recipient data from a list/table, calculate results, then update Word/PowerPoint templates. This enables the rapid creation of personalized data-intensive documentation. However, unlike Mail Merge, the documents must be updated one at a time. 
The example below looks up company data from an Excel table based on a drop-down list, calculates results, then updates text, a table, and a chart in Word/PowerPoint. This process would have to be repeated for each recipient.
	Based on our analysis, we believe Berkshire Hathaway could save $351 billion by purchasing our solution. Act today and you can purchase it for only $75 billion.

	Per Employee	Company Total (Billions)
Our Savings	 $930 	 $350.6 
Competitor Savings	 $300 	 $113.1 
Solution Cost	 $200 	 $75.4 


	



[bookmark: _Currency_Switching][bookmark: _Toc531342351]

Localization (Currency and Language)
It is often important to be able to easily localize (currency and language) assessment tools and results documents. For example:
· supporting users who are located in different regions
· creating documents for customers located in other countries
Currency Switching (currency symbols and exchange rates)
This example shows how to change currency symbols and exchange rates (via a drop-down selection) in your Excel and destination documents.
See Excel Worksheet: Currency Switching
	Your net benefit is expected to be ¥25,630.

	One Time	Annual Recurring	Project Total
Total Investment	¥11,391	¥2,278	¥22,782
Total Benefits	¥5,696	¥8,543	¥48,412
Net Benefit			¥25,630


	



[bookmark: _Language_Switching][bookmark: _Toc531342352]Language Switching
The example below shows how to change language (via a drop-down selection) in your Excel and destination documents. It also changes currency.
ソリューションビジネスバリューアセスメント
私達の分析に基づいて、私達はあなたの会社が救うことができることを信じる ¥22,782億ドルのソリューションを購入しています。今日の行為は、あなただけのためにそれを購入することができます¥25,630億。
	

	一回	年間定期	プロジェクト合計
総投資額	¥11,391	¥2,278	¥22,782
合計特典	¥5,696	¥8,543	¥48,412
純利益			¥25,630


	



[bookmark: _Import_Data_-]Often organizations have a destination document template for each language and a single Excel workbook is used to update the dynamic content in the destination documents. 
This is often combined with the Excel table “Disable Cell Updates” feature. Table row/column header text is left unchanged in each document (which are in different languages) and only the cells with data are updated. This avoids the need to transfer the text (in each language) from Excel to the Word/PowerPoint tables. 
The “Cloud Reporting” in the Enterprise version is also very helpful with this scenario: the user selects the region (currency/language) in an Excel drop-down, completes their assessment, then simply selects the desired report template (there would be one for each language) from a drop-down in the add-in and they download the personalized report in the customer’s preferred language/currency.
Import Data - Importing external data into Excel
Users commonly import data from external sources into Excel, so it can then be consolidated/analyzed in Excel and then updated in Word and PowerPoint documents. Common data sources include website data; databases; Azure; CRM/ERP systems, such as Salesforce; other Excel workbooks, web services, XML/JSON data, etc. 
Here are a few Microsoft resources that may be helpful:
· Import data from external data sources (Use Excel's Get & Transform (Power Query) experience to import data into Excel from a wide variety of data sources. You can then use the Query Editor to edit query steps to shape or transform data.)
· Get & Transform in Excel Get & Transform enables you to connect, combine, and refine data sources to meet your analysis needs.
· Overview of connecting to (importing) data This reference article discusses importing and connecting data. You will learn about tasks like importing, updating, securing, and managing data.
Most major software/app vendors provide ways for users to securely import data into Excel. There are also many 3rd-party solutions, including other add-ins, to help connect Excel to apps and other data sources. Microsoft’s Power BI is also commonly used to import and analyze enterprise data.
The Enterprise version also contains a “Data Refresh” feature that can automatically update frequently updated data (such as pricing and exchange rate data) every time the workbook is opened.
[image: ]
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